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1.0 Manual Guidelines

1.1 Document History

Issued Issue Change Issue Reason for

By Date Control ID No. Change

LA March 2009 OMGAMUK 1.1 New Instructions

LA Oct 2009 OMGAMUKSW 1.32 New Instructions upgrade
V1.3.06 GAM software

LA Apr 2010 OMGAMN 1.41 New Instructions (Biogas
Check)

1.2 Notes

Important/useful information and instructions are shown clearly throughout the manual in
a note format.

For example:

&5 Note: For further information please contact Technical Support at Geotech (UK)
Limited on +44(0)1926 338111 or email technical@geotech.co.uk.

1.3 Biogas Check Instrument Users

Users operating a Biogas Check instrument need only to refer to the following sections of
this operating manual:

2.0 Introduction Page 5

3.0 Software Installation and Removal Page 10

4.0 Getting Started Page 14

5.0 User Interface Page 21
Omit section 5.5

6.0 Instrument Communication Page 27
Omit sections 6.3, 6.4

10.0 Getting Readings from an Instrument Page 57

11.0 Problem Solving Page 63

12.0 Glossary of Terms Page 64

2 Note: For GA & GEM range analyser users all sections of this operating manual apply.

© Copyright 2009 Geotechnical Instruments (UK) Limited Page 5
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2.0 Introduction

This manual explains how to use Gas Analyser Manager (GAM) for the GA2000, GEM2000 and
Biogas Check range of instruments listed below:

GA9%4
GEM500
GA2000
GA2000 Plus
GEM2000
GEM2000 Plus
Biogas Check

5 Note: These instruments are sensitive pieces of scientific equipment, and should be
treated as such.
2.1 Gas Analyser Manager (GAM)

Gas Analyser Manager (GAM) enables communication with the range of gas analysers
listed above in section 2.0 in order to configure the instruments and download data. The
GAM application contains powerful new features to help with the organisation of data and
remote access.

All data on the PC is stored in metric and converted to the current unit of measurement of
the attached instrument.

The main features of GAM are:

. Organisation and transfer of IDs and readings to/from the gas analyser.
. Configuration of the gas analyser.
. Flexible grouping of IDs.

. Structured organisation of transferred data.

. Auto detection of instrument type and available options.

. Secure data mode to prevent tampering.

) Borehole detection via GPS.

. Email and FTP of downloaded readings.

. First time set-up wizard.

. Facility to import existing Datafield Communications data.

2.2 What's New in Version 1.4

In addition to the features of version 1.1, 1.2 and 1.3, version 1.4 supports:

e UK Biogas Check.
e SMTP Authentication.

© Copyright 2009 Geotechnical Instruments (UK) Limited Page 7



OMGAMN1.41 Gas Analyser Manager

2.3

What's New in Version 1.3

In addition to the features of version 1.1 and 1.2, version 1.3 supports:

2.4

Borehole detection via GPS (Global Positioning System) latitude and longitude
coordinates to aid site navigation.
Manage location data.

Improved reading viewer.

What's New in Version 1.2

In addition to the new features of version 1.1, version 1.2 supports:

Landtec BioGas instrument.

Searching for an ID.

The ability to specify source as instrument serial number when saving readings in
Monitor Pro format.

Support for V3.02 Gas Analyser firmware, featuring programmable residual N, alarm
levels.

The default configuration folder for new installation has moved to the All Users folder
to allow easier sharing of configurations.

2.5 What’'s New in Version 1.1

. When using a GEM2000 Plus; readings are downloaded from the instrument from
both the GA and GEM operating modes. IDs are transmitted to the instrument in the
mode specified on each borehole.

. When importing a ‘GAM Export File’ the user has the ability to specify sites to import
and how to control the overwriting of existing data.

. More than one serial port can be scanned for instruments and the software can
automatically detect connection of an instrument.

. Supports the ‘Event Log’ and ‘Technician Log-in’ features of the latest model GA2000
and GEM2000 instruments.

. Enhanced ID editing facilities, change only selected parameters of a group of IDs.

. Create and label readings that were recorded without an identifier.

. Store user calibration information in downloaded readings file inline or in the header
block.

. Supports instrument upgrade facilities.

. Improved performance.

Page 8 © Copyright 2009 Geotechnical Instruments (UK) Limited
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2.6 Compatibility
The software is designed to run on the following operating systems:

) Microsoft Windows 2000 Service Pack 4.
) Microsoft Windows XP Service Pack 3.
) Microsoft Windows Vista Service Pack 1.

) Microsoft Windows 7.

The software requires that Microsoft.NET V2.0 components and MDAC 2.8 are installed.
These installations will be carried out during the software installation.

© Copyright 2009 Geotechnical Instruments (UK) Limited Page 9
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3.0 Software Installation and Removal

3.1 Software Installation

Gas Analyser Manager is provided on CD. The user installing the software must sign onto
the PC with ‘Administrator’ privileges.

1) Insert the CD into the CD/DVD drive. The CD will automatically (autorun) start up
and the following screen is displayed:

H About Geotech ‘
’ Operating Manual

Iq‘.. Install Software .

Software Installation CD Home Screen

2) To install the Gas Analyser Manager programs select the ‘Install Software’ button and
the installation will commence.

During the installation the user will be guided through the ‘Setup Wizard’ and
prompted to make various selections and choices. Once user choices have been
selected, click the ‘Next’ button to move the installation onto the next stage.

= i )
i Geotechnical Instruments Gas Analyser Manager

Welcome to the Geotechnical Instruments Gas
Analyser Manager Setup Wizard

The installer will guide you through the steps required to install Geotechrical Instrurments Gas
Analyzer Manager on your computer.

WARNIMG: This computer program iz protected by copenght law and international treaties,
Unauthorized duplication or distribution of this program, or any portion of it, may result in severe civil
or criminal penalties, and will be prozecuted to the maximum extent pozsible under the law.

Software Installation

Page 10 © Copyright 2009 Geotechnical Instruments (UK) Limited
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3)

4)

5)

6)

r i Geotechnical Instruments Gas Analyser Manager f_”§|g| |

License Agreement

Fleaze take a moment to read the license agreement now. IF pou accept the temas below, click "l
Agree'. then "Mest". Othemwise click "Cancel".

END-USER LICENSE AGREEMENT FOR GEOTECHNICAL INSTRUMENTS
(UK) LTD SOFTWARE
IMPORTANT-READ CAREFULLY

This Geotechnical Instruments (UK) Ltd End-User License Agreement
("EULA") is & legal agreement between you (either an individual or a single
entity) and Geotechnical Instruments {UK) Ltd for the Geotechnical
Instruments (UK) Ltd software product identified above, which includes
computer software and may include associated media, printed materials,

and "online"” or electronic documentation ("SOFTWARE FRODUCT"). By bt
()1 Do Mot Agree (@) | &gres
’ Cancel l ’ < Back ] I Met »

Software Installation

| i& Geotechnical Instruments Gas Analyser Manager E] |§|g|

Select Installation Folder

The ingtaller wall install Geotechnical Instruments Gas Analyzer Manager to the following folder.

Tainstall in this folder, chick "Mext”. Toinstall to a different folder, enter it below or click "Browse".

Folder:

C:%Program FileghGeotechnical Instruments UK, Lid4G astinalysertd an: Browse...

Install Geotechnical Instruments Gas Analyser Manager for yourself, or for anyone who uses this
computer:

() Everyone
) Just me

[ Cancel l [ < Back ] [ Mewst »

Software Installation

Select the ‘Next’ button to continue with the installation or select the ‘Cancel’ button
to cancel and exit.

Select 'I Agree’ followed by the ‘Next’ button and the following screen is displayed.

Choose either the default folder path to install the software programs into or select
the ‘Browse’ button and install the files into your chosen folder. Choose whether to
install the software for ‘Everyone’ or ‘Just me’ on the current PC followed by the

‘Next’ button to continue.

Select the ‘Next’ button to confirm installation and wait for the software programs

© Copyright 2009 Geotechnical Instruments (UK) Limited
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r i# Geotechnical Instruments Gas Analyser Manager E| |§|E| ‘

Installing Geotechnical Instruments Gas
Analyser Manager

Geaotechnical Instruments G as Analyzer Manager iz being installed.

Please wai...

Cancel

Software Installation

7) When the installation is complete, select the ‘Close’ button to exit the ‘Set-Up

Wizard'.

& Note: Itis important to restart the PC after software installation.

-iig' Geotechnical Instruments Gas Analyser Manager E| |§| Pz|
Installation Complete @
Geotechnical Instruments Gas dnalyzer Manager has been succeszfully installed.
Click "Close" to exit.
Please use Windows pdate to check for any critical updates to the WET Framework.
Software Installation
8) The operating manual may also be viewed and installed to your computer for
reference from the ‘Install CD’.
9) To exit the installation CD select the ‘Exit CD’ button from the CD ‘Home Page’ and
reboot the pc.

& Note: If your computer does not already have Microsoft.NET V2.0 Framework
installed it will be installed automatically during the software
installation.

Page 12 © Copyright 2009 Geotechnical Instruments (UK) Limited
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3.2 Software Removal

To remove Gas Analyser Manager and all associated files the user must sign onto the PC
with ‘Administrator’ privileges, otherwise the removal request is denied by the operating

system.

1) To remove the software once installed, select ‘Start’ from the desktop and then
‘Control Panel’.

2) Select the ‘Add/Remove Programs’ icon, highlight ‘Geotechnical Instruments Gas
Analyser Manager’ and select ‘Remove’.

S
Change or
Remove
Programs

%

Add New
Programs

Add/Remove
Windows
Components

@

Set Program
Access and
Defaults

Currently installed programs: [0 show updates Sort by:
@ Geotechnical Instruments Gas Analyser Manager Size s.998
Click here for support information. Used frequently

Last Used On 24/09/2005
To change this program or remove it from your computer, dick Change or Remove.
s | |

ﬁlGeoTechS ice
Geotechnical Instruments Gas Analyser Manager

Size 6.48MB

@+ Google Tog Size 3.47MB
ﬁl High Defini

& He Busine: Size  17.16MB
& HP Help Size  0.54MB

[T} HP Image ] Size  167.00MB

[T} HP Image Size 3.84MB

[ HP Update Size 3.56MB
ﬁl HP User Guides 0003 Size 0.00MB
W HP Wireless Assistant 1.01C1 Size 1.03MB
ﬁl Huawei Modems Size 2.72MB

&5 Hypersnap-DX 5 Size 4,28MB
E InterVideo WinDVD Size 45.02MB
"B IntroCreator V2 Size 2.08MR_ ¥

& Note:

Add or Remove Programs

3) Restart the PC after the software has been removed.

Deleting the Gas Analyser Manager application does not automatically
remove Microsoft.NET V2.0 Framework. Take into consideration other
applications which may use Framework before removing from the

‘Add/Remove Programs’ option.

© Copyright 2009 Geotechnical Instruments (UK) Limited
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4.0 Getting Started

4.1 Program Start-up

Once the software is installed connect the analyser to the PC via the USB or serial cable.

1) To start the application double-click the desktop shortcut for ‘Geotech Gas Analyser

Manager’.

A

Geotech Gas
Analyser ...

Desktop Icon

2) Alternatively, select ‘Start’ from the desktop, then ‘All Programs’ and select ‘Gas
Analyser Manager’ from the Geotechnical Instruments program folder.

4.2 Running the Software for the First Time

When running the software for the first time, the ‘First Time Usage Wizard’ will guide the
user through specifying important software settings. The user may decide whether to
complete the options and settings following the ‘Wizard’ or to select the ‘Next’ button
through to the end and complete the options from the menu options within the GAM

application.

1) Follow the on-screen instructions to complete the process.

Geotechnical Instruments Gas Analyser Manager

I Welcome to Gas Analys

This is the first time you

Back | [ Net> | [ Cancel |

GAM Software Wizard

Page 14
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4.2.1 Communications Port

The ‘First Time Usage Wizard’ will prompt for a serial port. Select the serial port to which
the instruments are normally attached. If the computer does not have a serial port, use
an RS232 to USB converter. Prior to running the software for the first time, install the
device and any driver software that it requires. Upon completion note the ‘COM’ port
number assigned to the USB serial adaptor.

Geotechnical Instruments Gas Analyser Manager

Communications Port

Select serial port for instrument C G e0tec h

communications

Choose the serial port to which you normally cor
Geotechnical Instruments Gas Analysers.

If you are using a USB to senal port adapter you
computer does not always assign it the same COM p
this situation you can change the port by choosing O

Tools menu.
Sedalport | ECUTEM v |
Help [ < Back ][ Next > ] [ Cancel ]

GAM Software Wizard

2) If using a USB converter new/different port numbers may have been assigned when
connecting the adaptor to a different USB port than the one initially used. In this
case you can choose a new serial port by selecting ‘Options’ from the ‘Tools’ menu
within the GAM application.

& Note: More advanced serial port communication options are available after
running the software for the first time.

3) Select the ‘Next’ button and the ‘Data Folder’ screen is displayed.

4.2.2 Data Folder
The user must have read/write/delete permissions on the folder.

4)  Specify a folder for the configuration data; borehole IDs, questions, comments and
readings. The specified directory can be a local path nhame or a network share.

© Copyright 2009 Geotechnical Instruments (UK) Limited Page 15
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Geotechnical Instruments Gas Analyser Manager E]@

C Geotech

A subsidiary of S LANITED

Data Folder
Specify z location to store your data.

Specify a folder to store your datz, this can be
new one which will be created if necessary. Iti
new folder.

The folder is used to store configuration data and
from instruments. You must have read, write and d
the folder. The folder may be on z local disk or a neb

Data folder: struments\Gas Analyser Manager\Data) |

[ <Back |[ Met> | [ Cancel |

GAM Software Wizard

4.2.3 Units of Measurement

The units of measurement can be set to metric or imperial. This setting only affects the
specification of borehole diameters and is independent of the instrument settings. When
data is uploaded to the instrument the values are sent in units of measurement
compatible with the current instrument settings.

5) Specify ‘Metric’ or ‘Imperial’ and click the *‘Next’ button.

Geotechnical Instruments Gas Analyser Manager

Unit of Measurement Selection

Choose the Units of Measurement for PC C GEOtECh

A subsidiny of S aNoTER

Select metric or imperial units of measurement
This setting does not affect the unit of meas
instruments. Yalue are converted during data tr

® Metric
O Imperial (USA

Units of measurement:

[ <Back [ Net> | [ Cancel |

GAM Software Wizard

Page 16 © Copyright 2009 Geotechnical Instruments (UK) Limited
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4.2.4 Importing DataField Comms V3 Data

Borehole IDs, Comment Files and Question Files can be imported from DataField Comms
software. It is not necessary to import the files during the set-up wizard; files can always

be imported at a later time. GAM data files are saved in a different format to DataField
Comms.

6)

7)

8)
9)

10)

Import Borehole ID Files
Select the files to be imported

Add files to be imported by
clicking the Browse button.
You can select more than one
file at a time.

If you do not have any files to
import or wish to do it later

click Next.

7 [ < Back Jl Next > J LCanceI J

GAM Software Wizard

To import files select the ‘Browse...” button and select one or more files to import.
The first page enables the user to import ‘Borehole ID Files’. Choose the files to
import, then select the ‘Next’ button and a prompt to import ‘DFC Comment Files’
will display.

Select the ‘Browse...” button again to choose the files to import.

Select the ‘Next’ button to continue onto the next stage.

Repeat the above steps for DFC Comment files and DFC Question Files if required.
Please refer to the next page for details.

25 Note: To import DataField Comms V3 files from within the GAM application
please refer to ‘Section 8.0 - Importing and Exporting Files’ of this
operating manual.

© Copyright 2009 Geotechnical Instruments (UK) Limited Page 17
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Geotechnical Instruments Gas Analyser Manager FZ]

© Geotech

A subsidiary of S paoTES

Import DFC Comment Files
Select the files to be imported

Add files to be imported by
clicking the Browse button.
You can select more than one
file at 3 time.

If you do not have any files to

import or wish to do it later
click Next.

Browse...

Help [ <Back |[ Next>

l

[ Cancel ]

GAM Software Wizard

11) Select the ‘Next’ button to continue onto the next stage.

Geotechnical Instruments Gas Analyser Manager @@

C Geotech

A subsidiary of 2 panaTED

Import DFC Question Files
Select the files to be imported

Add files to be imported by
clicking the Browse button.
You can select more than one
file at a time.

If you do not have any files to

import or wish to do it Iater
click Next.

Browse...

= e

Help [ <Back || _MNet> | [ Cancel |

GAM Software Wizard

12) Select the ‘Next’ button to continue onto the next stage.

Page 18
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Geotechnical Instruments Gas Analyser Manager

Import Wizard Set-up Comp

You have finished specif
click Finish to begin i

[ <Back || Fnsh | [ Cancel |

GAM Software Wizard

13) Select the ‘Finish’ button to complete and exit the ‘Installation Set-Up Wizard'.

4.2.5 Create First Site using the Wizard

The ‘Create First Site Wizard’ enables the creation of the first site. If using this software
to configure gas analysers for use with a number of sites, further sites can be created
after configuring the software for first time use.

If you prefer, you can skip this stage by clearing the ‘Create a Site with the details
specified below’ checkbox and set up sites using the options in the GAM application.

Geotechnical Instruments Gas Analyser Manager @@

© Geotech

A subsidiary of S apnoTen

Create New Site
Enter Site and Borehole Group details

Gas Analyser Manager organises its data around
with 2 common prefix or sets of letters. Enter
description and the characters in the ID that are

Create a Site with the details specified

Site name: I |
Description: l

Borehole ID Prefix: |........ ]
Site guestions: | v |

Comments list: [ |;“

You can leave the Site Questions and Comments:
stage. If you operate a single site leave the prefix

Help [ <Beck |[ Net> | [ Concel |

Create New Site

© Copyright 2009 Geotechnical Instruments (UK) Limited Page 19
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A site is a collection of borehole IDs that normally share a common borehole ID prefix

If the borehole ID structure has not been identified yet enter a prefix of *....... . A'Site

Name’ must also be specified. At this stage there will not be any 'Site Questions’ or
‘Comment Files’. These will need to be added later.

4.3 Exit the Application

To exit and close the Gas Analyser Manager application, select ‘File’ from the drop down
menu then ‘Exit’ or, click on the ‘X icon’ at the top right of the application window.

C Geotech Gas Analyser Manager

Fe &5 Yen Immturert Tods reb
Ny ’ w A 4 1 ' » o) \
Import., Conrmct Corigre Data Setip Iegort Expoct
Export Confguraton % 3 s K o P
Zave Locaton Dats as K4 cutes | Tedncers | Instruments | Ireument
Ext Find
= N 575 Test Gite
» ia Al Rocered Readegs
G hnical Instr ts (UK) Lad
Gas Analyser Manager 1.3.02

Exit Gas Analyser Manager

Page 20
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5.0 User Interface

5.1 Default Application Screen

The default application screen displays the 'Sites’ tab. The main areas of operation are
divided into seven tabs across the top of the main window. The most common operations
are available on the toolbar below the drop down menu options. The status bar along the

bottom of the screen shows the instrument’s connection status; when a connection is in
progress the serial number and type of instrument is also shown.

Drop Down Menu C Gortrc i Gas Analywet Managrs
Options ~—afve =i e

V e - Detatz Oucserect  Doe
TOOIbar / M2t Coewests | See Questeed | Boutes  Tedviirs | Iebuvests | Dy

Application 1~
Tabs : e

Search /

User Defined /
Settings

Selected Tab e
Information

Status Bar

Default Application Screen

Drop Down Menu Options

The drop down menu options enable the user to select specific tasks. Move the cursor
along the tabs to display the options available. A number of options may be displayed in
grey text, indicating that that particular option is not available at that time.

Toolbar
The toolbar displays the most common tasks peformed by the user. Click on the relevant
toolbar icon to action.

Application Tabs
There are seven application tabs available to the user. The user may move freely from tab
to tab. Most tabs require that an instrument is connected to the PC.

Search

The search facility enables the user to enter in search criteria about the sites created. For
example, enter a borehole ID or first few characters of the search criteria and select the
‘Find’ button. If a match is found the data will be displayed.

User Defined Settings

The user defined settings lists a hierarchy tree of folders that have been set up by the
user, i.e. Site, Borehole Groups and IDs. Click on the + next to the folder name to drill
down further and display folder/file content. Click on the - to close the folder information.
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Selected Tab Information

This window displays the information and fields relevant to the tab selected by the user.

Status Bar

The status bar along the bottom of the screen shows the instrument’s connection status,
i.e. grey when not connected, yellow whilst searching for an instrument on a serial port
and green when an instrument has successfully been detected. The instrument’s serial
number and model type are shown. The bottom line contains status information and
communication error messages. The progress bar updates when downloading readings

and uploading borehole ID information.

5.2 Drop Down Menu Options

Click on each menu tab to display the options available. The option is only available to the
user if it is displayed in black text (greyed out text is not available for selection).

5.2.1 File Menu
New Site -

New Borehole Group -

New ID -

New Route -

Import -

Export Configuration -

Save Location Data As KML -

Exit -

5.2.2 Edit Menu
Delete -

Edit -

Select ‘New’ then 'Site’ to define and set up new
site information.

Select ‘New’ then ‘Borehole Group’ to create, edit
and delete multiple borehole groups.

Select ‘New’ then 'ID’ to create, edit and delete new
borehole IDs.

Select ‘New’ then ‘Route’ to create, edit and delete
borehole routes created for ease of use by the Site
Engineer.

Select ‘File’ then ‘Import’ to select and import an
existing data file into GAM.

Export configuration enables the user to export the
configuration file from the existing PC. For
example, if an organisation has a central database
which holds all regional data, for speed, the
settings may be exported into a new site database.

This option enables the user to save the current
borehole locations identified using the GPS tracking
feature as a ‘.kml’ (Keyhole Marking Language) file.
The saved file and borehole locations may then be
viewed using Google Earth, Google Maps or
Microsoft Virtual Earth to visually locate each
borehole location.

Exits the application and returns the user to the
Windows desktop.

Select ‘Edit’ then ‘Delete’ to delete the selected
item.

Select ‘Edit’ then ‘Edit’ to update the selected item.
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Cancel Changes

Save Changes

5.2.3 View Menu

Reading Download Set-up

Refresh

5.2.4 Instrument Menu

Connect

Download Readings

Get IDs

Upload Data

Disconnect

5.2.5 Tools Menu
Options

5.2.6 Help Menu
Contents

About

Select ‘Edit’ then ‘Cancel Changes’ to cancel the
last changes made.

Select ‘Edit’ then ‘Save Changes’ to save the
changes.

Select ‘View' then ‘Reading Download Set-up’ to
set-up the default rules when downloading data.

Select ‘View’ then ‘Refresh’ to refresh the screen
displayed.

Select ‘Instrument’ then ‘Connect’ to connect GAM
to the attached device.

Select ‘Instrument’ then ‘Download Readings’ to
download readings from the instrument into GAM.

Select ‘Instrument’ then ‘Get IDs’ to get IDs.

Select ‘Instrument’ then ‘Upload Data’ to upload
data settings from GAM to the instrument.

Select ‘Instrument’ then ‘Disconnect’ to disconnect
the instrument correctly from GAM before exiting
the application.

Select ‘Tools’ then *Options’ to configure serial port
and application set-up options.

Select ‘Help’ then ‘Contents’ to search and view
help text. The GAM application is installed with
extensive help text available to the user. The user
may either enter search criteria, or click on the
folder topic to expand the detail.

Select ‘Help’ then ‘About’ to display information
about the version of GAM currently installed.
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5.3 Toolbar Buttons

O .

Mew

The ‘New’ button creates a new item depending upon the currently
selected tab and item. Other items can also be created by clicking the
drop down button on the right-side of the ‘New’ button.

The ‘Edit’ button puts the currently selected item into edit mode. If
the selected item cannot be edited this button will be disabled. During

Edit editing the ‘Save’ and ‘Cancel’ buttons are available.
- The ‘Cancel’ button aborts the changes to the item currently being
Cancel edited, reverting the data to its original state.
- The ‘Save’ button saves the changes to the item currently being
Sae edited.
X The *Delete’ button deletes the currently selected item.
Delete
ﬂr’i The ‘Connect’ button when selected begins polling the serial port for
Connect the Geotechnical Instruments Gas Analyser. When one is discovered
the ‘Instrument Status Bar’ turns green.
v The *‘Disconnect’ button ends the communication with the current
Disconnect instrument. The option is enabled only when an instrument has been
found.
“Tli The ‘Download’ button begins the download of readings from the
Dowrload instrument to the GAM application.
45 The ‘Upload’ button begins the upload of IDs, question files and
Upload comment files from the GAM application to the analyser. The item
uploaded is determined by the currently selected tab and item.
) The ‘Configure’ button allows the instrument communication settings
Configure to be modified and configuration of other software settings.
E The ‘Data Setup’ button allows the format of the reading data files to
Data Setup be configured.
i The ‘Import’ button allows previously exported configurations to be re-
Import imported.
i The ‘Export’ button allows the user to export the system configuration
Export for backup purposes, for importing onto another installation or for
problem diagnostic analysis.
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5.4 Application Tabs

After configuring the software the user is presented with the main application screen which
has the following seven application tabs available for selection.

Sites
The 'Sites’ tab is the main window for configuring the ‘Borehole IDs’, ‘Reading Download
Options’ and a folder tree view showing the sites, borehole groups, IDs and download data.

Comments
The ‘*Comments’ tab enables the creation, editing and deletion of comment files. Comment
files are used in singe/multi-choice site and borehole questions.

Site Questions
The 'Site Questions’ tab enables the creation, editing and deletion of site questions files.

Routes
The ‘Routes’ tab enables the grouping of borehole IDs by site or borehole group.

Technicians
The ‘Technicians’ tab enables the creation of technician ID codes.

Instruments
The ‘Instruments’ tab shows a list of all instruments that have been connected.

Instrument
The ‘Instrument’ tab enables the configuration of the instrument and calibration dates to
be checked.

5.5 Terms

This section provides a brief explanation into some of the terms used throughout GAM.

5.5.1 Sites

A ‘Site’ is a group of boreholes within a common location. Boreholes within a site are
identified by one or more matching characters in the borehole ID. Usually the first few
characters of an ID are fixed. If not using a common set of characters in the ID, sites
can still be created to organise the data.

Within GAM a site is uniquely identified by its ‘Site Name’. Within a site, boreholes may
be subdivided into groups. For instance, you may wish to group types of borehole by
location within the site, or by reading frequency requirements.

Another common aspect of a site is that the boreholes share the same comment files and
site question files. When using a GA94 or GEM500 instrument 'Site Questions’ are not
used and therefore this parameter is ignored.

5.5.2 Borehole Groups

A ‘Borehole Group’ identifies a set of boreholes within a site. The nature of the grouping
is entirely up to the user. A borehole ID may only exist in one group at a time. A small
site may have a single set of boreholes only and not make use of grouping.

5.5.3 Boreholes
A ‘Borehole’ is a single sampling point on a site that is identified by a unique eight
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character identifier. The borehole can be a well-head, borehole or any other fixed point
where a gas measurement is taken.

5.5.4 Question Files

‘Question File’ define up to five site questions that can be answered by the user on a
GA2000/GA2000 Plus or GEM2000/GEM 2000 Plus. Four styles of question are available;
simple text answers, value answers, and single or multiple-choice questions from a pre-
selected list of comments.

Up to three borehole specific questions may also be defined.

5.5.5 Comment Files

A ‘Comment File’ defines a list of up to 64 text strings that are used as the selection
choice in the single or multiple choice question files for site or borehole specific
questions.

5.5.6 Routes

A ‘Route’ is a mechanism that allows the pre-selection of several sites, borehole groups
or individual boreholes for simultaneous uploading to an instrument. This option is useful
where an instrument is used across several sites.

It is also used to enable the user to order the IDs according to the sequence in which the
Site Engineer walks the route when sampling. You can define several sequences
containing various combinations of sites, borehole groups and/or individual IDs.
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6.0 Instrument Communications

6.1 Connecting an Instrument

After installing and setting up the software it is recommended that the user confirms that
the instrument(s) can communicate with the software.

1) Plug the instrument into the serial port specified earlier. You can change the chosen
port by choosing ‘Options’ from the ‘Tools’ menu.

2) The software automatically determines the type of instrument connected. Select the
‘Connect’ button or select F9.

With GA94 and GEM500 instruments it is necessary to cycle the power of the instrument
and choose ‘Option 4 - Download’ on the analyser after selecting the ‘Connect’ option.

& Note: GA2000, GEM2000 or BioGas instruments; the instrument must be at the *‘Main
Gas Read Screen’ before attempting to connect.

When the instrument is found, the ‘Status Bar’ at the bottom of the screen turns green and
displays the model number and serial number of the instrument. The ‘Instrument’ tab will
now be enabled and the ‘Instrument’ option becomes available.

C Geoteeh Gas Analysie Matiage ‘:ﬁm!
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Instrument Connected

3) Select the ‘Status’ tab of the ‘Instrument’ tab and the instrument details will be
shown. To connect another instrument select the ‘Disconnect’ button, attach the new
instrument, then select ‘Connect’.

& Note: All configuration functions of the software can be carried out without
having an instrument connected. Instruments need to be connected
when uploading a new configuration or downloading readings to the
computer. Gas Analyser Manager can be configured to detect instruments
automatically as well as configured to detect instruments on multiple
serial ports.
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6.2 Configuration Options

1) To change the configuration of the software, select ‘Options’ from the ‘Tools” menu
and the following options are available:

Options D |-

Serial ports: [l COM1 [T Connect automatically
1 COM3
™ Scan all ports

Latlong display format: (¢ Decimal ( Degrees, Minutes, Seconds

Units of measurement: & Metric Imperial (USA)

Data folder: IC:\Users\F'ublic\Geoted'lnicaI Instruments\Gas Ar ...

GPS distance warning: |15 3: metres

[V Automatically synchronise instrument clock
[V Show speed uparade prompt
GAS4/GEM500 Date Format
@ ddimmlyy O mmiddlyy (USA)

— Email SMTP Server Settings

SMTP Mail server: Imail
Username: {ANother
Password: |

Sender email address: Ian.other@domain.name

Test

0K Cancel

Tools - Options

Serial Ports All serial ports fitted to the computer are listed. Place
a tick next to the serial ports you may attach your
analysers to or tick ‘Scan all ports’ to have the
computer attempt to find a computer on any serial
port.

Connect automatically Ticking this option allows the software to
continuously scan for an instrument and it will
connect and disconnect from the instrument
automatically. Using this option disables the
‘Connect’ and ‘Disconnect’ options on the toolbar.

Scan all ports Tick this box to have the computer scan all serial
ports on your computer. You would not wish to
enable this option if you have other devices
connected to some serial ports on your computer.
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Lat/Long display format

Units of measurement

Data folder

GPS distance warning

Automatic clock synchronisation

Show speed upgrade prompt

GA94/GEM500 date format

Email SMTP Server Settings:

‘Latitude and longitude coordinates’ can be
associated with each ID. Choose the default display
format. Either ‘Decimal’ (e.g. 52.123567) or
‘Degrees, Minutes, Seconds’ format (e.g. 52° 32m
12.2315s).

Select either ‘Metric’ or ‘Imperial’ units of
measurement, this is the unit of measurement the
software uses and is entirely independent of the
configuration of your instruments. However to avoid
confusion you should ensure that you configure your
instruments to use the same units of measurement.

This is the folder where the configuration including
download readings are stored. This should be a folder
where you have read/write permissions and it may
be on a shared network folder.

When viewing readings downloaded with coordinates
data, the software can compare the original location
specified against the ID with the location of the
instrument when the reading was taken.

When the distance is more than the amount specified
in this parameter the reading's row is highlighted in
red.

The ‘Automatically Synchronise Instrument Clock’
option enables the instrument’s internal clock to be
set to that of the computer each time a connection is
established. This option is not set during the initial
‘Setup Wizard’; the setting can be changed at any
time.

The latest GA2000 and GEM2000 analysers have the
ability to communicate at twice the rate of old
analysers. Ticking this option will cause the user to
be prompted to upgrade the speed of an analyser
when it connects. When the upgrade is applied, the
instrument will switch off and you will have to restart
the instrument.

If you are using GA45, GA94 or GEM500 gas
analysers select the date format of your instrument.

The email server settings are used by the facility to automatically email readings to a
specified address as they are downloaded.

SMTP mail server

Username

Specify an SMTP mail server to make use of the
option to automatically email readings as they
downloaded. Specify an IP address or mail server
domain name, e.g. mail.mycompany.com

Specify the username required to logon to the SMTP
server. If a domain name is also required, precede
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the username with the domain name followed by a
backslash. For example: domain\username

Password Specify the password of the username required to
logon to the SMTP server.

Sender email address If you specify an SMTP mail server you need to also
specify a sender's email address, as a valid internet-
format email address.

Test Button:

To test the email settings click the 'Test' button. An email will be sent to the Sender email
address. A success message or error message will be displayed.

2) Select the 'OK’ button to accept the changes or ‘Cancel’ button to exit without saving
the changes.
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6.3 GPS Option

GPS works by receiving signals from satellites in orbit around the earth. These satellites
are not geostationary and therefore move across the sky. By picking up the signals from
these satellites the GPS chip can work out its position.

The number of satellites that the GPS chip can locate will affect the accuracy of the
position obtained. In general, the more satellites located the better. In practice, 4 satellites
will give a reasonable fix, while 8 or more will improve accuracy.

The number of satellites that can be located depends on their position in the sky and also

on how much of the sky the instrument can ‘see’. The satellite signals do not pass through
buildings and are seriously attenuated by trees and vegetation. The system will therefore

not work well in built up areas and forests. The performance will also be degraded if close
to a single building, which will tend to cut off half of the view of the sky.

The GPS chip and compass are switched on when the instrument is switched on. When
first switched on the instrument will take a period of time to locate the satellites and
obtain a fix. This time period will vary according to the satellite location, signal strength,
and visible sky, but is typically between 30 seconds and 2 minutes. If the instrument has
been switched off for an extended period of time or has moved a long distance since it was
last switched on the time to obtain a fix will be extended further.

The GPS chip remains on while the instrument is on. This maximises the speed of
response. A facility is available via the menu functions, to turn off the GPS location page.
This is intended for situations where the GPS guidance is not required. This does not turn
off the GPS chip, which remains operational, and GPS data is still stored with the gas
readings.

In order to fully utilise the GPS feature borehole IDs must be created with ‘longitude’ and
‘latitude’ coordinates predefined then uploaded to the instrument before readings are
taken. Specify; degrees, minutes, seconds or decimal angle.

C Geotech Gas Analyser Manager
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6.4 Manage Location Data

After taking readings containing coordinate data, download the readings to the PC using
the ‘Download’ button on the toolbar.

Green Highlighting: Indicates that the readings coordinates are within the tolerance
specified (default 16 metres) of the sample point's defined location.

Red Highlighting: Indicates that the readings coordinates are outside the tolerance
specified (default 16 metres) of the sample point's defined location.

Yellow Highlighting: Indicates that the readings have new coordinates and the ID does not
yet have any location data defined.

Select the ‘Manage location data’ button to update the ID definition with new coordinates.
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Manage Location Data

25 Note: The ‘Location Difference’ column is always shown when latitude and longitude
information is stored, regardless of whether or not it is included in the saved
data file. To update the master location for an ID click the ‘Manage Location
data’ button at the top right corner. For each ID you wish to update click the
‘Update Records’ check box at the end of the row and then click the ‘Apply’
button at top right of the window.
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7.0 Define Site Settings
7.1 Define Site Settings Process - Best Practice

STA
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applicgtion Step 1 CEmmené —Step 2
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Step 4
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Step 8
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Best Practice:

The above schematic is considered to be best practice when setting up the site data and is
meant only as a guide. Step sequences may change dependant upon individual
requirements and standards.

Double-click on the ‘GAM application’ icon on the desktop to start the application and
check that you have connection from the analyser to PC via the USB cable and that the
status at the bottom of the application screen reads connected.

Step 1 Create a comments file to hold the site and ID question information.

Step 2 Create up to five site questions.
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& Note: It is best practice to set up ‘Steps 1 and 2’ before ‘Step 3 -
Site Name and Site Details’ During the site set up, the user
will be asked to select the ‘*Comments File’ and 'Site Questions
File” attached to that site.

Step 3 Create the site name and site details.
Step 4 Create borehole groups.

Step 5 Create borehole IDs.

Step 6 Using the GPS Feature?

‘YES’ Go to Step 7

‘NO’ Go to Step 8

Step 7 Enter borehole coordinates.

Step 8 Create technician IDs.

Step 9 Create routes.

Step 10 Upload settings from GAM to the analyser.

Step 11 Take readings and samples.

Step 12 Set up the ‘All Received Readings’ option in GAM.
Step 13 Download data readings from analyser to GAM.
Step 14 END

& Note: The analyser must be at the ‘Main Gas Readings’ screen to
upload or download data.

7.2 Sites Tab

A 'Site’ is a set of boreholes at the same location that can usually be identified by a
common set of characters in the ‘Borehole ID’.

7.2.1 Creating a New Site

1)  From the 'Sites’ tab, click the ‘New’ toolbar button or choose ‘New’ from the File
menu.

2) Select 'Site’ from the menu and the following screen is displayed:
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Create a New Site

3) A new 'Site folder’ item is created; complete the following parameters:

Site Name

Description

Borehole ID Prefix

Site Question File

Comments File

Enter a short name to identify the site; enter
only characters that are valid filename
characters.

Enter a description of the site. This field is
optional.

If the site can be identified by a set of
common characters in the borehole ID, enter
the characters that are appropriate. Leave the
other characters set as a full stop.

Select an existing site question file that is
associated with this site. If no site question
file has been created yet, leave this section
blank. A file can be selected once a site
question file has been created.

Select an existing comment file that is
associated with the site. If no comments file
has been created yet, leave this field blank. A
file can be selected once a comments file has
been created.

2z Note: When creating several sites, ensure that all borehole ID masks are unique
and unambiguous. For example, if Site A has a mask of “SITE....” and
Site B a mask of “"SITEB...” this could lead to confusion because Site A’s
mask would also be included in “SITEB...".

4) To store the changes, select the ‘Save’ toolbar icon or ‘Save’ from the ‘Edit’ menu.
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&5 Note: Borehole IDs can now be created. Borehole IDs within a site can be
grouped for easier identification and use.

7.2.2 Editing Site Details

1)  From the main ‘Sites’ tab, select the ‘site name’ from the names in the folder tree.
2)  Select ‘Edit’ from the ‘Edit’ menu or select the ‘Edit’ toolbar icon.
3) Enter the details and select the ‘Save’ button.

& Note: If a site or site name is changed, the route will need to be modified to

reflect the changes.

7.2.3 Deleting a Site

1) From the main 'Sites’ tab, select the ‘site name’ by selecting the name in the tree.
2)  Select ‘Delete’ from the ‘Edit’ menu or click the ‘Delete’ toolbar icon.

&5 Note: Once a site has been deleted the data cannot be restored. All associated
borehole IDs will also be deleted.

7.3 Borehole Groups

A ‘Borehole Group’ is used to organise lists of borehole IDs within a site. All sites have at
least one borehole group. There is no limit on the number of borehole groups that can be
created to organise a site’s boreholes; you can create as many as you need to organise
your site’s boreholes. A single borehole can only exist in one group at a time.

7.3.1 Creating a Group

1) Select the site in the folder tree for which a group is required.

2) Click the ‘New’ toolbar button or select ‘File’ menu item and select ‘Borehole Group’.
A new item will appear below the site in the folder tree with the name ‘<New>".

C Geotech Gas Analyser Manager
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New Borehole Group

3) Rename the word <New> with the new group name.
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& Note: Borehole IDs will be created under the selected borehole group.

7.3.2 Editing the Group’s Name

The name of a group can be edited by clicking a second time on the group name in the
tree or by entering ‘Edit’ mode and editing the name in the borehole ID list in the right-
hand window.

7.3.3 Deleting a Group

Click on the borehole group name and select the ‘Delete’ button. All borehole IDs in the
group will be deleted permanently.

7.3.4 Re-ordering Borehole IDs within the Group

The order of the borehole IDs in the group will be the order in which they appear in the
instrument. It is useful to set the order of the IDs to match the order in which they are
typically read on site.

In addition to setting the order within the group, if required, a different ordering can be
used when creating routes.

1)  Select the group name in the folder tree. The right-hand panel shows a list of
borehole IDs within the group.

2)  Select the ‘Edit’ button from the toolbar or menu.

3) Borehole IDs can be moved using the shuffle buttons (up/down arrows) on the left-
hand side or by dragging and dropping one or more items in the list.

4)  Select the IDs to be moved using the mouse. To select several IDs at the same
time use the Shift and Ctrl buttons to make multiple selections.

7.3.5 Moving Borehole IDs to a Different Group

As with moving IDs within the same group, select the IDs to be moved. Then, using the
mouse, drag and drop the items into the new borehole group entry in the tree.

7.3.6 Editing Borehole ID Details from the Group List

One or more borehole IDs to be edited can be selected by choosing the ID from the
appropriate group. Either click a second time on the borehole ID or right click and
choose 'Edit’ from the context menu that appears. To edit more than one ID at the same
time, select the IDs as described above, right click and choose ‘Edit’ from the context
menu.

& Note: For Gas Analyser Manager Versions prior to version 1.1, when editing more
than one borehole ID at once all IDs will be given the same properties except
for the borehole ID value.

7.3.7 Borehole (Sample Point) IDs
All references to borehole IDs include well-heads and any other identifiable location
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where gas readings and flow measurements are taken. For each borehole ID users can
specify which types of Geotechnical Instruments Gas Analyser are used with the

borehole.

With GA45/GA94 type instruments only the borehole ID and whether or not pressure data

is read can be entered. With GEM500 and GEM2000 instruments the flow device and
associated parameters can also be specified.

For GA2000/GA2000 Plus and GEM2000/GEM2000 Plus instruments you can enter the
comment text, pump run-time and up to three borehole questions.

& Note: If an organisation uses a combination of instruments a single configuration can
be used. There is no need to generate separate data for each type of
instrument. When configuration data, i.e. borehole IDs are sent to an
instrument, the software works out the type of instrument and appropriate
settings to ensure the relevant data is stored to the instrument. To enable an
instrument type to receive an ID, ensure the checkbox is ticked.

7.3.8 Borehole Parameters
The borehole editor form has the following parameters:

Parameter

ID(s)

Type

Instruments

Record system
pressure

Record borehole
flow

Prompt to store

Description Applicability

An eight character identifier for a All types of instrument.
borehole. An identifier can consist

of letters and/or numbers in any

combination. Uppercase letters are

considered different to lowercase

letters. All eight characters must

be specified.

Select from a drop down box. All types of instrument.
Choose from other, well, probe,

sample port, horizontal collector or

biogas.

Tick boxes, one for each instrument
type. Place a tick next to the
instrument type(s) to be used with
this borehole ID. The options
selected determine the parameters
below that become available.

When selected, the instrument will GA94/GEM500/GA2000
prompt the user to take a relative

pressure reading from the borehole

or wellhead.

When selected, the user will be GA2000 and GEM2000
prompted to record flow either
using internal flow sensor.

This option allows CO readings to GA/GEM2000 Plus

H»S be taken where there are high
levels of H2S present.
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Information

Flow device

Longitude and
Latitude

Pipe diameter

Orifice diameter

Pump run-time

Questions

Alarms

Enter any information considered
useful to the operator. This text
can be viewed on the instrument
by the user; enter details that
enable the user to locate the
borehole or wellhead.

From the list choose the type of
flow device. Depending on the flow
device, enter pipe diameter and
orifice diameter information in the
adjacent fields.

Specifies the global position of the
ID using latitude and longitude
coordinates. If the location is
unknown leave these values as 0.0.
You can toggle the default display
format by selecting ‘Options’ from
the ‘Tools’ menu. Alternatively, to
toggle quickly between the two
formats available right click on the
value and choose the display
format from the menu.

Coordinate data can also be set
using the ‘Manage location data’
option when viewing previously
downloaded readings.

When required, enter the pipe
diameter. Note the units of
measurement shown.

When required, enter the orifice
plate diameter.

Enter the pump run-time.

Enter up to three specific questions
for the borehole.

Up to ten alarm conditions per ID
can be specified. When per-ID
alarms are specified, only two per-
ID questions can be specified.
Alarms can be specified on CHy,
CO,, O,, Anemometer,
Temperature Probe, 1PSI Pressure,
5PSI Pressure, Barometer, GEM
Flow, GEM Power and the three
internal cells, identified as Cell1,
Cell2, Cell3. The user may specify
the same channel more than once,

GA2000/GA2000 Plus
GEM2000/GEM 2000 Plus

GEM500
GEM2000/GEM2000 Plus

GPS equipped Geotech gas
analyser. GA2000/GA2000
Plus GEM2000/GEM2000
Plus

GEM500
GEM2000/GEM2000 Plus,
with orifice plate, pitot
tube, user input or
anemometer.

Orifice plates.
GA2000/GA2000 Plus
GEM2000/GEM2000 Plus

GA2000/GA2000 Plus
GEM2000/GEM2000 Plus

New GA2000/GA2000 Plus
GEM2000/GEM2000 Plus
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if required, to have an alarm
condition when a value falls
outside of a specified range.

7.4 Creating New Boreholes

In the folder tree view of the 'Sites’ tab, select the borehole group in which the ID needs to
be created, select the ‘New’ toolbar button or ‘New - Borehole ID’ menu item on the ‘File’
menu.

7.4.1 Creating a New Block of Sequential Borehole IDs

If using blocks of borehole IDs that share or mostly share the same parameters, a block
can be created easily using the ‘Create Sequential Block’ option available when creating a
new borehole ID.

1)  Select ‘New Borehole ID’ from the ‘File’ menu.

2) Select the button adjacent the borehole ID field labelled ‘Create Sequential ID
Block’.

 Create Sequential ID Block EE|

Mask: 1A......

|lse @ as |letter mask and # a5 numeric
mask. For example: ABCDEEHE

Start value:

End value:

Cancel

Create Sequential ID Block

3) The ‘Mask’ field shows the borehole ID mask specified for the site. Fill in the
remainder of the characters with those characters that will be common among the
group. To create the numeric or alphanumeric (A..Z,0..9) sequential list, enter a #
symbol for numeric characters or @ symbol for alphanumeric.

4) In the field ‘Start value’ enter the first value. In the field ‘End value’ enter the final
value.
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In the ‘Start value’ and ‘End value’ fields key in the same number of characters as
the number of # and @ symbols specified in the ‘Mask’ field.

In the ‘Mask’ field all character spaces must be filled in with a letter, number, # or
@ character.

For example:
Start End
Mask Value | Value Result
LEAXXX # # 12 56 LEAXXX12,LEAXXX13,...,LEAXXX55,LEAXXX56
LEABB@#Q A8 B3 LEABBASQ,LEABBA9Q,LEABBBO0Q,...,LEABBB3Q

5) Select ‘Preview’ to view a list of the IDs that will be created when saving the data.

Create Sequential ID Block @E|

Mask: 1RARFF#F#

|lse & as letter mask and # a5 numeric
mask. For example: ABCDEE%E

Start value:  |[SWO0IN
End value: SWoo15s

1ASWORMN 1ASWDD4
1ASWOD02 1ASWDDS
1ASWOD03
1ASWODD4
1ASWOD0E
1ASWODDE
1ASWOODT
1ASWOD0E
1ASWODDG
1ASWOD0
1ASWOINM
1ASWOD2
1ASWDD13

Preview [ Create ] [ Cancel

Create Sequential ID Block

6) Once the values shown in the Preview list are complete, select ‘Create’ to return to
the borehole ID editor where the configuration details of the borehole can be added.

7) Select the ‘Save’ button to store the new boreholes to the borehole ID list.

7.4.2 Editing an Existing Borehole ID

From below the borehole group tree item on the sites tab, select the 'ID’ and then click
the ‘Edit’ icon on the toolbar. Alternatively, choose an 'ID’ from the ‘Borehole Group’ list
and click a second time on the item to switch to the borehole details view.
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7.4.3 Searching for an ID

To search for a specific ID, enter the ID in the text box label *<search>" and select ‘Find".
If the specified ID exists, the ID will be selected in the tree. Partial IDs may also be
entered.

7.4.4 Borehole Questions

GA/GEM2000 (Plus) instruments can be configured to prompt the Site Engineer to answer
up to three borehole questions defined on a per-ID basis when the reading is stored
relating to the status of the borehole or wellhead.

There are four types of question:

Alphanumeric The user is prompted by a question to input any
letter or number as an answer up to 72 characters
in length. The user is shown a single prompt.

Numeric The user is prompted by a question to enter a
value in a specific format as an answer. The user
is prompted to enter one or more values and a unit
of measurement is required to answer the
question.

Single Selection Comments The user is shown a list of up to 10 comments.
Only one answer can be selected.

Multiple Choice Selection The user is shown a list of comments. Up to eight
Comments answers can be selected by placing a tick mark
next to each choice.

7.5 Comments Tab

Comments files are used by site questions and borehole questions to allow the user to
select one or more textual comments. There are two types of question that use the
comments: single selection and multiple-selection comments.

Questions are currently only available on GA2000/GA2000 Plus and GEM2000/GEM2000
Plus models. If you are not using one of these instrument types, ignore this section.

An instrument can have up to 64 comments of up to 35 characters in length. Comments
are organised into files, only one file can be used at a time by an instrument and the file
used is selected on the 'Site Properties’ form. To ensure consistent usage site questions
specify the comment file to be used when a comment-type question is selected.

If using multiple choice comments on a site question the user is limited to selecting ten
comments. For borehole specific questions the user is limited to choosing eight comments
in total. This means that if, on a single borehole, three multiple-choice comments
questions are chosen the total number selected is limited to eight; for example three on
the first, four on the second and then only one can be selected on the third.

7.5.1 Creating a New Comments File

1)  Select the ‘Comments’ tab and either choose ‘New’ from the ‘File” menu or toolbar
button.
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2) Now up to 64 phrases can be entered, one per line in the edit window.
A number of useful pre-defined phrases can be added to the list of comments.

3) Select the ‘Add Standard Comments’ button. A menu of choices is shown. Select
an option to add the comments to the new file.

4) Select ‘Save’ to store the new comments. When creating or editing a set of site
questions, the new comment file can now be selected from the drop down list.

© Goctrct L Aralyser Masapye
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Comments Tab

7.5.2 Editing an Existing Comments File

1) Select the ‘*Comments’ tab and choose the file from the drop down list.

2) Enter Edit mode by clicking ‘Edit’ on the toolbar.

2 Note: Itis not recommended to delete an entry from the file by removing the
row. This will cause problems to existing questions that are using the
file. Instead you can re-use the row or leave it as an empty row.

7.5.3 Deleting an Existing Comments File

To delete an existing comments file, select the correct ‘Comments File’ and choose
‘Delete’ from the ‘Edit’ menu or toolbar.

& Note: All sites that use the comments file need to be modified so that they do not
refer to the deleted file.
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7.6 Site Questions Tab

Question files are used with the GA and GEM 2000 (Plus) instruments only. If you have
GA94s or GEM500s this section can be ignored.

The 'Site Questions’ tab allows users to specify additional information that the instrument
cannot read for itself. The type of information is up to the operator. Up to five site
questions can be stored in the instrument. These can, for example, relate to the weather
or the operator name. Site questions are answered by the operator choosing an option
from the ‘Instrument’ menu. Borehole questions are defined on a borehole specific basis;
up to three questions can be defined. Borehole questions can be used to prompt the user
to enter information relating to the status of the borehole or well-head.

7.6.1 Creating a Site Question File

1) Select ‘New Site Question’ from the ‘File’ menu or select the ‘Site Questions’ tab and
then select <<New>> from the drop down list.

C Cooterh Gan Avadiner MNarsaget

Site Questions Tab

2) Enter a file name for the site questions and click *OK’.

3) Up to five questions can be created. Select the question type from the ‘Question
Type’ drop down list.

There are four types of question:

Alphanumeric The user is prompted by a question to input
any letter or number as an answer up to 72
characters in length. The user is shown a
single prompt.

Numeric The user is prompted by a question to enter
a value in a specific format as an answer.
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The user is prompted to enter one or more

values and a unit of measurement is

required to answer the question.

Single Selection
Comments

Multiple Choice Selection
Comments

The user is shown a list of up to ten
comments. Only one answer can be selected.

The user is shown a list of up to ten
comments. The user can select up to eight

answers by placing a tick mark next to the

choice.

4) Select ‘Save’ on the ‘Edit’ menu or toolbar when the questions have been

completed.

7.7 Routes Tab

IDs in the instrument can be organised in a way more suited to the Site Engineer’'s method
of monitoring by creating ‘Routes’. A ‘Route’ is a collection of sites, borehole groups or
individual boreholes programmed into the instrument in a single block. When uploading a
route all existing IDs, questions and comments are first deleted from the instrument.
Multiple routes can be created and stored for later use. Create different routes to reflect

your site monitoring requirements.

7.7.1 Creating Routes

1) Select ‘New Route’ from the ‘File’ menu option or select the ‘Routes’ tab followed by

the ‘New’ toolbar icon.

2) Enter a name for the route in the ‘Selected Route’ text box.
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Routes Tab
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3)

4)

5)

6)

7)

8)

9)

7.7.2

Under ‘Available Sites and Groups’ the full list of sites and borehole groups are
shown. By clicking a borehole group the full list of borehole identifiers for that
group is shown in the ‘Available IDs’ list.

You can view a whole borehole group by selecting the group name and then
selecting the right arrow button adjacent to the list.

Adding a site or borehole group to the list will cause all borehole IDs in existence at
the time of upload to be sent, not just those that existed when the route was
created.

You can select individual borehole IDs by choosing one or more items from the
‘Available IDs’ list. Use the Ctrl and Shift keys when selecting to easily add sets of
IDs.

After adding the items the order can be adjusted by selecting the items in the
‘Selected IDs’ list and using the up and down arrow buttons on the right-hand side.

Select ‘Save’ to store the changes. The route can now be used with any
instrument.

Creating a route does NOT, in anyway, change the structure of your sites and IDs
outside of the defined route, enabling you to define them in any order without
affecting the master list of sites, borehole groups and IDs as defined on the ‘Sites’
tab.

Uploading Routes

Uploading a route will clear existing IDs, comments and site questions from the
instrument.

The comments and site questions uploaded will be those defined against the site
properties of the first ID uploaded. A warning message will be displayed if a conflict of
site questions and comments is found. In this case you should check which files are
correct and ensure that the selection is consistent.

Page 46

© Copyright 2009 Geotechnical Instruments (UK) Limited



Gas Analyser Manager OMGAMN1.41

7.8 Technicians Tab

GA2000 and GEM2000 gas analysers fitted with Firmware version 3 have a new option that
allows a technician identifier to be recorded against each reading taken. When the
instrument is started a list of technician identifiers and names is shown. The operator
selects their name from a list or they can type in a custom ID. The ‘Technicians’ tab allows
the user to create a list of ‘Technician IDs’ and names to be uploaded to the instrument.

1) From the ‘Technicians’ tab, select ‘Edit’ to enter edit mode and then enter IDs and
names in the list.
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GAZ0 (GALIZY) Cotessied

Technicians Tab

2) Once you have completed adding or editing names select the ‘Save’ button.

3) Make sure the analyser which is to receive the upload is connected. Finally, select
the ‘Upload’ button to send the list to your instrument. Existing technician names in
the instrument are deleted.

&5 Note: The ‘Upload’ option is not available if your instrument does not support
the feature or it has not been purchased for the instrument.
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7.9 Instruments Tab

The ‘Instruments’ tab displays useful instrument information for the
instrument(s)connected.

For example; serial number, model, instrument Firmware Version, model, next service due
date, date last connected, date last field calibration and last factory calibration date.
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Instruments Tab

&5 Note: The GA2000 Plus instrument listed above is highlighted in red indicating that

the next service due date has passed.
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7.10 Instrument Tab

Instrument maintenance and status information can be obtained by selecting the
‘Instrument’ tab.
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Instrument Tab

7.10.1 Instrument Settings
The ‘Instrument’ tab has the following sections:

Status Shows calibration dates, instrument type, battery and memory
status and Firmware version information.

Switches Allows the setting of auto-purge setting, auto power-off, low
flow warning sensitivity, purge pump run-time and technician
log-in enable.

Alarms For the setting of instrument alarm levels for CH4, CO,, O, and
Residual N, where supported by the instrument.

Logging For setting auto logging parameter ID, interval and pump run-
time.

Delete Allows the deletion of various parameters and cold-start of the
instrument.

Event Log Only available with GA2000 and GEM2000 analysers fitted

with Firmware version 3 which have purchased the Event
Logging option.

The Event Log shows system activity within the analyser
including when user-calibrations are performed and the values
obtained during the calibration. This information can be saved
to a file by clicking the ‘Save As..." button.
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To edit in

Also when readings are downloaded from the instrument the

software can be configured to put the calibration data from

the Event Log into the CSV (or other) file, either in the header

block or in-line chronologically with the readings.

strument settings the analyser must be connected. Select the ‘Edit’ button on
the toolbar or ‘Edit” menu, make the required changes and then select the ‘Save’ button

to commit the changes to the instrument.

Instrument Screens:
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Instrument - Alarms

Alarms can only be set with the GA/GEM2000 instruments attached. An audible and
visible alarm indication occurs on the instrument when the specified channel’s reading
falls below or rises above the specified value.
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Instrument - Logging

Specify an interval between readings time frame and pump run time.
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Instrument - Delete

To delete stored and downloaded readings, tick the relevant options and then select the
‘Execute Command’ button.
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Instrument - Event Log

The event log shows system activity with the analyser.
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8.0 Importing and Exporting Files

8.1

Importing Landtec’s DataField Comms V3 Data Files

Gas Analyser Manager is an upgrade to Landtec's DataField Comms V3 software.
Configuration files are stored in a new file format, however the user can import old data
files into this software.

To import IDs, question files and comment files select ‘Import’ from the ‘File’ menu or,
select the ‘Import’ toolbar button.

8.1.1 Importing Question and Comment Files

1)

2)

To import question files and comment files select ‘Import’ from the ‘File’ menu or,
select the ‘Import’ toolbar button.

Select one or more files to import. After importing the file it is available for
selection from the ‘Site Questions’ tab. You no longer need to keep your existing
files.

8.1.2 Importing Borehole IDs

Importing an ID file is just the same as importing questions and comments; however the
following points should be noted:

The IDs in the imported file will be analysed and moved into the appropriate Site.

For a Site with more than one Borehole Group, the IDs will be placed into the first Group
in the list unless the user selects the ‘Group Name' in the tree before selecting to import.

Where no matching ‘Site Borehole ID Mask’ is found a new Site will be created. When you

have specified an empty borehole ID mask (........ ) the IDs will be stored in that Site.

25 Note: Files cannot be converted back to DFC file formats.

8.2

Importing the System Configuration

The Gas Analyser Manager Export Configuration option creates a file with the extension
.DVE. These files can be imported back into Gas Analyser Manager.

1)
2)
3)

4)

Select ‘Import’ from the ‘File’ menu or select the ‘Import’ toolbar icon.
Select the backup file to ‘Import’ then click *Open’.
Select the Site or Sites to import to files into.

Select the method of import from the ‘Import Mode’ list.

Delete all existing Sites, groups and This option will overwrite, without warning

borehole IDs all existing configuration data including all
borehole details. Existing readings will
remain intact.

Only add new Sites, groups and IDs This option will only add Sites and the
associated data that do not already exist.
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Add new, overwrite existing data This option will merge the current

without prompting configuration and new data in the Export
file. You will be prompted before overwriting
any existing borehole configurations.

Add new, prompt to overwrite This option will merge the current
configuration and new data in the Export
file. You will not be prompted before
overwriting any existing borehole
configurations.

5) When you have chosen the sites and import mode select the ‘Import’ button.

8.3 Exporting the System Configuration

This enables the user to export the system configuration for backup or transfer to a
different computer by using the ‘Export Configuration’ option. This facility is also useful for
diagnostic analysis by the Geotech Technical Support team should they require a copy of
your configuration in order to identify a problem.

1) Connect to an instrument, select the ‘Export’ toolbar button and the following screen
is displayed:

Export Configuration

Sites to export: GPS Test Site

Export filename: E]

Cancel

Export Configuration

2) Place a tick next to the Site(s) you wish to export and then select the name of an
export file to hold the exported configuration. To browse for a file click the [...]
button.

3) Select the ‘Export’ button to export the data. If the specified file does not exist you
will be prompted to create the file. Specify a file name placing the file in a preferred
folder on your computer.

4)  The following message displays when the file export has been successful.
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Data exported successfully.

5) The exported file can now be used as a backup of the configuration or for importing
into another system.

6) Select 'Save’ to store the configuration. The file can now be sent using the preferred
email software.

The exported file contains the borehole details, comments, questions, and Routes
you may have created. Download readings are not exported.
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9.0 Organising Data for Instrument Upload

Configuration data can be uploaded (sent) to an instrument by choosing the item to send
from the ‘Site’ folder tree, ‘Comments’ tab, ‘Site Questions’ tab or ‘Routes’ tab and clicking
the ‘Upload’ button on the toolbar.

Borehole ID information can be uploaded in this way by choosing a borehole group within a
site or by uploading the whole site.

Activities can be organised in a way more suited to the user’s method of monitoring by
creating routes. A route is a collection of sites, borehole groups or individual boreholes
programmed into the instrument in a single block. Multiple routes can be created and stored
for later use.

9.1 Uploading Routes

Uploading a route will clear existing IDs, comments and site questions from the
instrument. When appropriate, new sites and comments can be uploaded to the
instrument.

The comments and site questions uploaded will be those defined against the site properties
of the first ID uploaded.

A warning message will be displayed if a conflict of site questions and comments is found.
In this case you should check which files are correct and ensure that your selection is
consistent.

9.2 Uploading Configuration Data and Readings

To send configuration data to the instrument, click the *‘Upload’ button or choose ‘Upload’
from the ‘Instrument’ menu. The ‘Upload’ option is enabled when a connection has been
established and the selected tab or item is valid for uploading. Site question files,
comment files, borehole ID groups and routes can be uploaded.

9.3 Uploading Readings

Existing readings can be uploaded back into an instrument. This is useful for GEM
instruments for comparison with previous readings. Only readings that have been
downloaded with the ‘Secure’ flag set can be uploaded back into the instrument. Files must
be saved in CSV format. Make a connection to the instrument; choose the file from the list
in ‘All Received Readings’ and click the ‘Upload’ toolbar icon.
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10.0 Getting Readings from an Instrument
10.1 Preparing to Download Readings
1) To set-up the default rules when downloading data select ‘View’ then ‘Reading

Download Set-up’ or select the ‘Data Setup’ toolbar icon and the following screen is
displayed:

C Geotech Gas Anabyser Manager

ATI730 Casnacied

View - Reading Download Set-up

2) Before downloading readings from the instrument the following parameters need to
be configured:

File format to store readings (CSV etc).

e Secure file.

o Field settings (the columns of data values and the order in the file that you want
to them displayed).

¢ Filename format.

¢ Naming convention for your data files.

e Post download processing options.

2 Note: GEM2000: With older instruments installed with version 2 Firmware it is
necessary to switch modes using the instruments on-screen menu to
download readings stored in each of the two operating modes.

3) To configure the download settings chose from the following options:
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File Formats:

Comma Separated Values (CSV)

Tab separated values

MPR Monitor Pro file format

Rungas file format

Field Settings button

Comma separated values; each row has all
data values for a single borehole reading.
The actual separator character is
determined by regional settings.

Similar to CSV except each reading value is
separated with a tab character.

Each row only contains a single channel’s
value.

This file format is very similar to CSV
except all non-numeric values such as
over-range and under-range are shown
with a single hyphen character.

Allows selection of columns to be stored
and their order.

. Column Editor ['57

Available Channels Selected Channels

Base channels v

Identifying character

[] When downloading. save data from new unreferenced channels

[] Include channels containing ne data

Cancel

Select the required columns followed by
the forward arrow > and send the
selections over to ‘Selected Channels’.

Column Editor s'

Avminthe Chasrals

Tooperation mad from wetemal probe

[ 'hen Soweicedeng aave date bom rew uvelersresd chanrals

7] nckude chansels contameng o 0o
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Secure Tick this box to have a code value inserted
into CSV or Tab separated text files. The
value inserted into the text file can be used
to ensure that the data in the file has not
been tampered with. The code formula is
not published. A stand-alone software
component to enable the scanning of a file
to ensure its validity is available from
Geotechnical Instruments UK Ltd.

Identify readings using instrument serial This option is only available when the file

number format is set to Monitor Pro. Ticking this
box will cause the source parameter to use
the instrument serial number. Otherwise
source is labelled ‘Field Reading’.

Filename Format Select a file naming convention from the
dropdown list or type in own filename
format. The extension (.csv, .txt or .mpr) is
automatically appended to the filename.

Formatting strings that can be applied to
the filename:

o [ComputerName] Adds the name of the computer to the
filename.

o [UserName] Adds the name of the authenticated user of
this computer.

o [LRDate] Adds the date of the last reading in
yymmdd format.

o [LRTime] Adds the time of the last reading in the
hhmmss format.

o [DLDate] Adds the date the data was downloaded in
yymmdd format.

o [DLTime] Adds the time the data was downloaded in

yymmdd format.

o [SerialNo] Adds the serial number of the instrument to
the filename.

Include additional information in files If this option is selected, the CSV files will
include the following parameters when the
file is saved: Instrument type, serial
number, time of download, calibration and
service dates.

Calibration information: GA/GEM2000 instruments with Firmware
version 3 or above can include user
calibration data in the downloaded readings
(where option is purchased).

« Do notinclude Information is excluded

e Include in header section The user calibration data is included in the
title section block of the data file.
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e Include in-line with readings The user calibration data is included in line
with readings in date order. This option
may make processing of CSV using external
software more difficult.

Automatically process after downloading If wishing to email, file copy or FTP the file,
tick this box to have the operation occur
automatically after the data has been
downloaded from the instrument.

Email readings Specify an email address to send the file to.
The file is sent as an attachment in a plain
text email. The PC must have a MAPI
compatible mail client installed such as
Microsoft Outlook. When the email is sent
after downloading, some versions of
Outlook will send a warning that an
external application is trying to access
Outlook. When this prompt appears the
external request must be accepted.
Multiple addresses can be specified by
separating each address with a semicolon
(no spaces).

Copy to specified folder Enter a local path name or UNC path name
to copy the downloaded file to after
downloading has completed. This will be
an additional copy of the readings to that
stored in this application's data folder.

Send readings to an FTP server Specify an FTP server address. This may
be a URL or IP address, a user name and
password. These settings will be available
from the user’s system administrator.

Field Settings:

Formatting the content of the files The columns to be stored and their order
within the file can be specified. Choose the
‘Format...” button to access the ‘Column
Order’ editor. Select the columns to be
saved from the list on the left-hand side.
They are grouped by instrument type.
Choose the instrument type and then select
the channels to be saved. Multiple
channels can be selected at the same time.
Click the right arrow button to move the
chosen channels to the ‘Selected Channels’
column.

Columns from more than one instrument
type can be chosen. Most channels appear
in most instrument types. A channel only
has to be selected once.

Note: If the user decides not to include a
channel and then later add that channel to
the selected list, any existing files will still
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only contain the original columns.

When downloading, save data from new  This option allows the user to be sure that

unreferenced channels when a new channel is added to an
instrument but it is not listed in either the
selected or available channels no data is
lost when downloading.

Note: Turn this feature off when using MS
Excel macros that are expecting a
predefined data format.

Include channels containing no data When this option is ticked channels that do
not have any valid values stored will be
included as an empty column; otherwise
the column is excluded.

4) Select 'Save’ to store the changes. These settings will be used each time the user
downloads readings from the instrument(s).

10.2 Downloading Readings

After configuring the software to download readings, select the ‘Download’ button on the
toolbar or select ‘Download Readings’ from the ‘Instrument’ menu.

The status window appears and shows the progress of the download. After downloading
the readings are saved in the specified format and processed if the automatic process
option was selected. The file is shown. If FTP was selected, the file will be FTP'd to the
specified location. If email was selected the file will be sent as an email attachment to the
chosen email address.

With version 2 Firmware instruments (serial number < 10000), ‘GA mode’ and ‘GEM mode’
readings stored in GEM2000 gas analysers are stored separately within the instrument.

When downloading readings from the latest GEM2000 analysers fitted with version 3
Firmware, the software will download the readings from both of the operating modes
automatically. The data will be stored in separate files.

10.3 Data Security

Gas Analyser Manager includes a facility for ensuring that data is secure by making
changes to the readings file evident when viewed in Gas Analyser Manager. To use this
facility, data from the instrument needs to be stored in the ‘Secure CSV' format.

The ‘Secure CSV' format incorporates a validation code that will identify if any changes
have been made to the data. The validation code formula is not published. A stand-alone
software component to scan a file to ensure its validity is available from Geotech (UK)
Limited. For further information please contact the Technical Support Team on +44(0)1926
338111.

An additional security feature is that data can be sent via either email or FTP to a remote
location directly from the instrument.
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10.4 Viewing Downloaded Readings

Below the ‘All Received Readings’ tree item on the 'Sites’ tab is a list of all reading files
downloaded. The view of the files is unfiltered. Under each 'Site’ a filtered view of the
readings file that only shows IDs applicable to the site borehole ID mask can be seen.

To view the downloaded readings in an external program right click the file and choose
‘Open using Excel’ from the context menu. The file will be opened using the registered
program for CSV file extensions. If using all-numeric IDs, Microsoft Excel automatically
determines this to be a numeric value and will truncate leading zeros.
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Example of Readings Opened Using Microsoft Excel

The readings data is automatically displayed in separated cells within the worksheet. The
data can now be analysed, reported and graphed using the MS Excel application.
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11.0 Problem Solving

Message

I can't get my USB
communications lead to work.

Every time I store a reading
the analyser asks if there is a
H,S filter attached, how do I
stop this message appearing?

I have just used my flow pod
with my GA2000 and after
downloading the results, the
flow data isn't there.

I have recently purchased a
new GA2000 plus and noticed
the residual nitrogen feature.
Can I have this feature enabled
for my other earlier gas
analysers?

I have tried to load my GA2000
with a second set of IDs but
when I do, the first set of IDs
is over-written.

I am using Gas Analyser
Manager and my data and ID
have disappeared.

Automatic detection could not
be started; the port may be in
use by another application.

2 Note: For further information please contact Technical Support at Geotech (UK) Limited

Action Required

Check ‘Windows Device Manager’ to ensure the

USB driver is installed. Check the USB port has
a COM port number mapped and that the port is
assigned on ‘Tools’ then ‘Options’.

This message can be configured to be ID specific.
Use Gas Analyser Manager (GAM) to toggle the
H,S filter flag accordingly.

It is likely that the reading was stored before the
logging period had elapsed. The logging period
must be allowed to run its course.

No. The memory has been extended on your
new analyser allowing us to add features such as
this. However, if using the latest version of Gas
Analyser Manager, the residual Nitrogen can be
calculated and downloaded as an extra channel.

To upload more than set of IDs from different
groups of sites, you need to use the ‘Routes’
facility which can be found in Gas Analyser
Manager.

Check that your ‘Data Folder' is set to the correct
location of your files. This can be found in the
‘Tools' menu then ‘Options'.

Check the analyser is connected to the PC and
that the USB port has a COM port number
mapped. Select ‘OK’ to continue and assign a
port number by accessing ‘Tools’ then ‘Options’.

on +44(0)1926 338111 or email technical@geotech.co.uk.
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12.0 Glossary of Terms

Administrator

Borehole

Borehole Groups

Comment File

Connected devices

Download

Firmware

GAM

Question Files

Route

Service due date

Site

Upload

The Administrator for the PC (Client) onto which
Gas Analyser Manager is to be installed and who
has the required security privileges needed to
install and remove Gas Analyser Manager
program files.

A borehole is a single point on a site that is
identified by a unique 8-digit character identifier.
The borehole can be a well head, borehole or any
fixed point where a gas measurement is taken.

A borehole group identifies a set of boreholes
within a site.

A comment file defines a list of 64 text strings
that are used for selection choice for site or
borehole specific questions.

Instruments (analysers) currently connected to
the PC via USB port(s).

Transmission of data from the instrument to the
GAM application (IDS, readings, questions etc).

Firmware is the name given to the analyser’s
internal software. The Firmware software is
automatically updated when the analyser is
returned for servicing.

Geotech abbreviation for Gas Analyser Manager .

Question files define up to five site questions
that can be answered by the user on the
GA2000/GA2000 Plus or GEM2000/GEM2000
Plus. Four styles of question are available.

A route is a mechanism that allows the pre-
selection of several sites, borehole groups or
individual boreholes for simultaneous uploading
to an instrument.

The date the next service is due for the selected
device. Instrument icons are highlighted in red

in the application, indicating that the instrument
is past its service due date.

A site is a group of boreholes within a common
location.

Transmission of data from the GAM application to
the instrument (IDs, question files, comment
files etc).
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